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Introduction:

FirstClass represents a radically new way to use your modem with your Macintosh.    After using 
it a few times, you'll probably agree that FirstClass (or "FC" for short) is the best online service 
you've ever used.    The speed and backgrounding abilities are second to none, and the ease of use 
is already legendary here
in 1993.

However, most people have a little trouble believing that FC is as good as it is, and are 
"brainwashed" into certain modes of operation by too much use of PC based BBS's.    In this text 
file, I will point out a few hints and tips that will help you along the way of becoming a 
FirstClass power user.

 
lients and Servers:

The program you run on your Mac is called the "client", and the system that you call up is the 
"server".    The server itself is a small process that runs in the background on any Mac, and 
operates much like PrintMonitor in that you just fire it up and forget about it, it has little or no 
interaction with the user at all.

In fact, the system administrator also uses the same program you do to run the whole process, 
they simply have a few more commands pop up in their menus that we don't get as an average 
user.

Since it's a client and a server, you must have the most up to date software on both ends to get all 
of the latest features.    If you don't have the newest version and can't access some feature, don't 
worry, it will tell you.    Some additions can be made at one end or the other, but these are a 
minority.
  
Another thing to keep in mind is that, with the Macintosh front end “client”, the system does 
error correction for you.    If you have the GUI (you're calling from a Mac), then the error 



correction is automatic. v.42 and various MNP modems are not required to get error free 
connections with a FirstClass system.    I've been asked if FC is XModem or ZModem, but the 
information is passed back and forth between the client and server in a proprietary "sliding 
window" format called FCP.

 
ettings files:

Unlike many systems, FirstClass stores information about different systems in different 
documents, called "settings files".    These hold the custom icons and sounds for that system, as 
well as the more obvious items like the phone number or baud rate.
  
If something goes wrong with the settings file, it may not work at all.    At that point your best bet 
is to run the FirstClass client directly, log on with the "vanilla" application, and download a fresh 
copy of the settings file for that system.

 
our Resume:

Under the "Edit" menu you'll find a selection for "Resume".    Type in one that you like, telling us 
about you. Please be sure to include your address and phone, so the Administrator can reach you. 
To see a resume, simply double click on a name, anywhere.    What to see mine?    Find a 
message by me, open it up, and double click on my name.

This works ANYWHERE.    If you select "Directory" from the "Message" menu, you can double 
click there.    If you are writing to someone in a letter, you can double click there.    If you select 
"Who's online" from the "Conference" menu, you can do it there...    basically, you can do it 
ANYWHERE, and it works with conference names too. While we're on the topic of the 
directory, if you want a full userlist, type "*" in the directory dialog.    Watch out though, it may 
be rather large.

 
t's "Administrator", not "sysop":

The person that runs any FirstClass system is the "Administrator", not a "sysop" as in most 
BBS's.    Write all questions to that person.

 
sername vs. your name:

People logging on with a Mac rarely have this problem, but for people using a PC, it is a cause of 
confusion.    There IS a difference between your username and your real name.    Think of your 
username as an alias that only you and the Administrator will ever see.

When you log on for the first time with the Mac front end, you will be asked for your name and 
other vitals.    NOTE:    for your address, please give Street address AND city/postal code (zip). 



From this, the system will create a username and password for you.    Note that you can change 
either one at that time in the new user dialog box.    Your username can be ANYTHING, and the 
system simply defaults to your first initial followed by your last name.    Since the username and 
password are used to log you in, it's something like having two passwords, and is very secure.

PC users logging in with a terminal will see a very different procedure.    The first time they log 
in, the FC server will ask them for their username right off the bat.    Typically, people fall back 
on their PC BBS experience, and type in their real name, thinking this is what it is asking for.

By the way, if you are using the Client application on the Mac, you can save your username and 
password into the settings documents so that you don't have to type them in every time you boot 
it up.    Just click on the "Setup..." button you see in the login screen, type in the username and 
password in the boxes provided and then click on "Save".    Remember to erase these if you ever 
give this settings file to anyone.

Those using a regular telecommunications program can make scripts as usual to answer the login 
prompts.

 
ow...
who is this letter to?:

FirstClass makes mailing VERY easy.    If you are trying to address the file to a person, but can't 
remember how to spell their name, just type in a few letters of the first and last name, FC will do 
the rest.

For example, let's say you were trying to write a letter to me.    Instead of typing my whole name, 
you can type "mau mar" in the "To:" field.    FC will search it's user database and insert the 
correct name for you!    If the system finds more than one name that matches, a small window 
will pop-up on the screen, simply hilite the name you want, close the box and you're all set.

 
C frustration:

In a lot of cases, a person will write a letter to more than one person at a time, using the "Carbon 
Copy" or "CC:" field to add in additional receivers.    Note that you should not reply to these 
messages with the "Reply" command (in the message menu), because EVERYONE on the list 
will get a copy.

My advice is to write a new letter, and address it by hand.

 
e Careful with Reply:

In many cases, you'll find informational messages and conferences on a FirstClass system.    



Examples on MAGIC include the message in the Files conference about how to upload a file.    
Another common example is the News conference found on most FirstClass systems.

Please, do NOT Reply to these messages!    If you have further questions, write a letter directly to 
the administrator (use "New"), or get another user in a chat and ask them.    These informational 
areas are for outgoing mail from the administrator only, so please don't post to them.    If you do, 
your mail may never be read.

Another no-no is to reply to a message in a file area with a question about the attached file.    If 
you have a problem, write to the poster directly.    If you don't, the reply will clutter up the file 
areas with questions that really "belong" to other people, and your posting may never be 
answered.

 
ust what are Conferences?:

"Fake users" is the best answer.    They are just like any other mailbox, but they happen to have a 
flag set that makes them public.

So, a Conference is nothing more than a user with a funny name, and a custom icon on it's 
mailbox.    To send mail to a conference, simply address it to the conference as if it were a user.    
This leads back to the point above, if you reply to a message in News for example, News is the 
"person" that gets the message, the user you are really writing to may never see it.

Some conferences are for discussions.    In these conferences, those interested in the subject 
matter are likely to read all the contents.    Do post replies having to do with these conferences to 
the conference itself, so all conference readers can benefit by reading your posting.

To summarize:    Don't send replies to News-type conferences.    Do send replies to discussion-
type conferences.    Do send private replies directly to the poster, and not to the conference.    To 
insure that the poster gets your reply promptly, you can enter the poster's name in the CC field of 
the message.

 
eading messages:

When you first log onto a FirstClass system, you will find huge numbers of unread mail 
"waiting" for you.    A quick way to toggle the flag on a message is to option-click on it.    To 
toggle ALL the messages in a conference, simply option-click on the conference icon itself.    
(this can save a LOT of time.    You can still peruse the messages later, but next time you log in 
and see the flag set in a conference, you'll know that it contains NEW messages.

In order to save you time while reading a batch of new mail, press command-space (in 1.6x, this 
may change in the future due to conflicts with the Macintosh Script Manager) and the first 
unread message in that conference will open.    If you drag the window to where (and how big) 
you like it, pressing command-space will bring each additional item up in that window.    When 



you get to the last unread item, the window will close so that you can navigate to the next 
conference.
  
You can also tell the server to send the message listings to you in "upside down" (newest first) 
order.    In the "Preferences" item in the Edit menu, you'll see a check box for this option.
  
Also, if you "sort on topic" you'll get something of a threading effect.    Command-space will 
exhaust all the messages with one topic, and then move onto the next.

Please delete private messages after reading to save space.    If you wish to retain a message, save 
it locally.

 
essaging power:

Select a message in FirstClass (click on it once, just like the Finder) and select "History" from 
the "Message" menu, I think you'll find it interesting.

Select a message that you're in the process of writing, and go to the "File" menu and select "Get 
info...".    Now you can select a custom icon for the message, and everyone will see it.    In fact, 
you can do this with any object that you own in FirstClass (your mailbox and anything in it).

Messages getting messy in your mailbox?    Select "New folder" from the "File" menu and name 
it whatever you want (with the Get Info command).    File old messages away just like you file 
things in the Finder (drag them). Since you can have any number of open messages at once, feel 
free to cut and paste between them, or into other programs too. After sending a message, delete it 
from your mailbox to save space.

 
hats:

You can be in as many chats as you want.    There will usually be only one public forum on the 
typical system, but under the "Conferences" menu, you can use "Private chat" to open a chat with 
anyone online.    You can have as many chat sessions open as you want, just click on the one you 
want to type into.
To save the text in a chat session, simply do a "Save".    Makes sense right?    Works for open 
messages too.    Closing the window will tell the other people that you've left the chat.

 
he Power of Macintosh:
 
One interesting thing to watch is a first time FC'er download a file.    Invariably, they just sit there 
and watch it happen, waiting for it to finish.    Another sad case of PC BBS brainwashing.
SoftArc has programmed FirstClass to follow "WYSIWYCCO", a rather long acronym for 
"What You See Is What You Can Click On".    If you see anything in the FC system, you can 
double click on it.    NOTHING in FC has to be waited on!



It's quite possible (and fast, too) to have two chat windows open, several messages being read or 
written, and a file transfer all at the same time.      In most cases, a file transfer will not even be 
noticeable at all, you will see no slowdown in speed whatsoever. The current system (v1.6x) 
allows only one file transfer at once, but this will be "going away" shortly.

 
ploading:

Uploading is your duty.    On the majority of BBS systems you are "penalized" for uploading 
because you can't do anything else at the same time, so many users are "leaches".    However, in 
FirstClass, you can still go on and do everything else at the same time, so please, upload those 
files!

To upload, just write a message (the subject is typically the filename, and you provide a 
description of the file in the message body.)    Now go to the "Mail" menu and select "Attach 
file...".    Navigate to the file as usual in the Macintosh world.

 
rchiving Tips:

Currently, there are three popular programs for archiving.    The most popular in the Mac world is 
"StuffIt", the next is "Compact Pro", and the last is Disk Doubler.    The latter is a commercial 
program, and while it's abilities are superb, I can't see it becoming too major a player in    the PD 
market.
I (Maury) HEAVILY suggest using Compact Pro over StuffIt for all uploads, here is my 
reasoning...

a)StuffIt comes in many versions.    The most common is the older "StuffIt 1.51", then there is 
the newer "StuffIt Classic" (basically StuffIt 1.6) and finally "StuffIt Deluxe".    The problem is 
that the file formats used in these programs are NOT backwardly compatible.    If you make an 
archive in StuffIt Classic, users of StuffIt 1.51 are not going to be able to use it.    I find this 
rather odd considering that there are no major changes to the file format itself, IMHO.

b) Compact Pro is MUCH easier to use.    There's more to a user interface than windows and a 
mouse, you have to be able to understand what's going on.    Compact Pro is simply better 
designed.

c)    Compact Pro is faster than StuffIt.

d)    Compact Pro can unStuff StuffIt 1.51 files.    In order to do this, simply "Open…" the file in 
Compact Pro, or drop the StuffIt file on the Compact Pro icon in System 7.    What's most 
interesting is that Compact Pro is able to unStuff a large StuffIt archive FASTER than StuffIt 
itself in most cases.

e) Compact Pro makes smaller archives.    A classic example, QuickTime in StuffIt 1.5.1 format 



is 444k, in Compact Pro format it is 327k.    This is a very large difference, and will save you a 
lot of time uploading and downloading.

Also, it's a nice thing to put the files in a folder, and then archive the folder itself, rather than 
simply inserting the files one at a time into the archive directly.    This way, the user will have a 
single folder to work with after unCompacting, rather than a group of files that may be hard to 
gather if they get scattered around a large directory window.

 
ome files have messages, 
others don't.    Why?:

Because the ones without messages are actually a link onto the server's mounted disks, it's 
something like a "raw directory" command a typical PC BBS provides you with.    Those are 
actual files on a disk that you're looking at, not messages with attachments.
  
This makes it easy for the administrator to put up hard drive paths and CD ROM's (This system 
has one), without having to "upload" them all.    However, you lack the ability to give the user 
notes with the file, which is a major drawback.

The way to upload is with a message and an attachment.    It has many advantages, a subject 
rather than a filename, a description of the file, and the ability to attach several files to one 
message.

 
irstClass and 
high speed modems:

One of the major problems seen over and over with FirstClass is attempting to get a high speed 
modem working with it.    It's actually quite easy to do once you know what FC is looking for.

Most terminals don't know what the modem is telling them.    For example, if you log onto a 
system with your baud rate set to 2400, and you get a "CONNECT 1200", it's typically up to you 
to go in and change the link speed between the modem and the computer.    However, FirstClass 
is smarter than that, it has the ability to read the "CONNECT" messages, and change it's speed to 
match it.    That's what the "Autospeed" box means in the modem setup dialog.
  
However, users of high speed modems will note that the link between the computer and the 
modem is ALWAYS some fixed value, no matter what the actual link speed is to the other 
modem.    If that Autospeed box is on, and you are using handshaking, then FC will follow the 
line speed "report" from the CONNECT line, and try to talk to the modem at the wrong speed!    
You have a choice of actions to take... turn off handshaking and turn your modem into a high 
speed 2400 baud machine (which makes the modem state CONNECT 9600 etc., but you also 
lose the compression and error checking in this process), or get FC to understand handshaking.    
The way to do this is to turn on the "Hardware handshaking" switch, and turn OFF "Autospeed". 



If you do this, lock the baud rate to the highest speed that your modem can understand (19.2kbps 
for v.32 modems, and 38.4kbps for v.32bis modems, typically), and you should be OK.    
However, make SURE that the modem is using hardware handshaking too!

Another complicating factor is that FirstClass cannot use software handshaking, because it needs 
an 8 bit "clean" path.    This would not be so bad, but most high speed modems come "out of the 
box" set to software handshaking, not hardware.    It's up to you to change this.The way to do this 
is to add this "switch" to the "init string" that FirstClass sends to the modem.    To change the init 
string, go to the modem setup dialog and select a high speed modem.    It's possible that your 
particular modem is listed, and you'll be finished.    If it's not listed, select the "Hayes 9600 baud 
compatible" and click on the "Edit" button.    This will take you to the modem editing dialog.    In 
this, click on the "New" button, and type in a new name for your modem.    Select all the correct 
parameters, and add the command needed to turn on hardware handshaking to the init string (it's 
*F3 on mine).    Click on the "Save" button, and you'll have a new modem setup that will be 
selected in the pop-up menu in the modem setup dialog where it will leave you.    Keep pressing 
"Save" and "OK" until you are back at the login screen, and you should be ready to go. 
  
By the way, custom modem settings are stored in the settings documents.    If you have several, 
you'll have to go to each and make the new modem type, which can be a slow process.    A way 
around this is to open the application itself (double click on it, not a document), and add the 
modem there.    This way, the custom modem will be added to the program itself, and all your 
settings documents will be able to use it.

Here are some tips...

To find out the maximum speed your high speed modem can handle, open a normal terminal, set 
the rate to 14400bps, and type "AT" and hit return.    If the modem answers "OK", select the next 
higher baud rate (try 19.2kbps), and do the "AT" again.    Keep doing this with ever higher speeds 
set in the terminal, until the modem no longer answers your AT.    Typically, it will suddenly stop 
echoing your characters at some high baud rate.    When this happens, select the next lowest 
speed (the last one that worked), and you're all set.    Now set ALL of your terminals to use this 
speed, and turn on hardware handshaking in the modem AND the terminal programs.    If you use 
ZTerm, this will be a time consuming task, as you will have to select a setting in the dial menu, 
change the settings, save, go to the next one...

To get the init string right (for any modem), this is what FC is expecting...
a)No command echo(typically "E0")
b)    Text results (V1) 
c)    Extended result codes, but with no results for error correction etc. (typically "X4")
d) i) Hardware handshaking (if high speed, typically *F3)
- OR -
d) ii) Autospeed turned on (for low speed modems, or high speed modems with no handshake)
You can see why this works, without the command echo and with the numeric codes, all that is 
going to come back for all of the dialing process is a single number.    FC looks for this number, 
and displays the correct dialog or logs on depending on what it gets.    In 1.65, they had to allow 
either numeric or text result codes because every modem seemed to have different numeric 



results!    All is still not perfect though, because Apple's own modem (the 2400 baud one) used 
CONN instead of CONNECT.    Ahh the world of "standards"!
  
Make sure you have version 2.09 or later of the client software 
to avoid difficulties.

Another note, you may notice that the init strings provided by SoftArc have and "H" near the 
end, this hangs up the phone in case it was off-hook while receiving the init string.    Also, if you 
set the number after the "M" (not the &M) in the init string to 0 rather than 1, the modem will 
keep the speaker off all the time, handy for an office environment. 

Troubleshooting...

Q)I've got the new modem set up but the modem doesn't do anything, FC can't talk to it.
A)You have handshaking turned on in FC and don't have a Hardware Handshaking cable, or the 
modem has hardware handshaking turned on, and FC doesn't.    This situation will typically result 
in a rather informative error dialog from FC.

Q)OK, I've got the modem and FC talking, but as soon as the logon starts, it just stops and sits 
there, or it gets in a little ways and then stops.
A)The modem is attempting to use XON/XOFF handshaking instead of hardware handshaking.    
It sends the "OK, tell me when you've got all of this" message to the computer and then waits, 
and FC just sits there, not knowing what to do with it.    Turn on hardware handshaking in the 
modem! If all else fails, go back to 2400 baud with no handshaking, and leave the Administrator 
a message.

PLEASE KEEP THESE INSTRUCTIONS HANDY.
GO TO THE NEXT CHAPTER FOR A LISTING OF FIRST CLASS BBS NUMBERS.


